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Information Security

Notice!

This document is classified as “Restricted”. Restricted information is intended for Siemens’
employees and third parties (e.g., suppliers, customers) collaborating with Siemens only. This

means that it is possible to share information in this document with third parties that are

interested in our product on a “need-to-know” basis. However, distributing this document to

the public or publishing it on the internet is prohibited.
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1 Online Support

Click the following link for technical support:
http://www.siemens.com/lowvoltage/technical-support

Click the following link for the list of all FAQs, Hot fixes, and Service Packs:
www.siemens.com/Powermanager/support

For additional information to work with Powermanager, refer to the Powermanager
manual/Help.

1.1 Security Information

Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines, and networks.

In order to protect plants, systems, machines, and networks against cyber threats, it is
necessary to implement —and continuously maintain — a holistic, state-of-the-art industrial
security concept. Siemens’ products and solutions constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems,
machines, and networks. Such systems, machines and components should only be connected
to an enterprise network or the internet if and to the extent such a connection is necessary
and only when appropriate security measures (e.g., firewalls and/or network segmentation)
are in place.

For additional information on industrial security measures that may be implemented, please
visit https://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more
secure. Siemens strongly recommends that product updates are applied as soon as they are
available and that the latest product versions are used. Use of product versions that are no
longer supported, and failure to apply the latest updates may increase customer’s exposure to
cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS
Feed under https://www.siemens.com/industrialsecurity.
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2 Overview

Powermanager allows you to migrate projects of powermanager V3.6 HF1 to powermanager V5.1
or higher.

This process includes migration of configurations and data of the projects. Configurations of the
project including all device, report, and system settings and system trends are part of the
migration operation. Archived data over required period for selected devices is also a part of this
operation.

NOTE: For the ease of reference, all powermanager versions above V5.1 will be referred as new
powermanager.

You can perform this operation by using the migration tool. The migration operation consists of
two key workflows:

- Export from powermanager V3.6 HF1: Allows you to select the configurations and the
data to be migrated from powermanager V3.6 HF1 to new powermanager.
NOTE: You should have powermanager V3.6 HF1 to perform the export. Upgrade to
powermanager V3.6 HF1, if you are using an older version of powermanager.

- Import to new powermanager: Allows you to import the exported files from
powermanager V3.6 HF1 to new powermanager.
NQOTE: You should have new powermanager to perform the import. Upgrade to new
powermanager if you are using an older version of powermanager.

Migration Rundown:

To save time, we recommend you perform the procedures involved in migration workflow in the
following sequence:

Configuration Export
Configuration Import
Data Export

HwnN e

Data Import

new powermanager and powermanager V3.6 HF1 must be available in two different machines to
perform the procedures in the recommended sequence. Refer section Hardware Category
Definitions in System_Description_pm_6.0 document for hardware requirements. Ensure that the
machines involved in the migration process are in the same time zone.

NOTE: To transfer the exported folders from one machine to another, you are recommended to
have USB stick or USB Hard disk.

Below are few important details to be noted before continuing with the migration operation:

e Only server projects can be migrated. If you have an existing client setup, you must setup
the client afresh in new powermanager.
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e Custom panels are not included in this migration operation. Refer new powermanager

Help for more information on working with Graphics Editor to create similar templates.

e The device types that are not supported in new powermanager but supported in

powermanager V3.6 HF1 must be imported as Third-party device types in new

powermanager. Refer Prerequisites for Import section below for more information.

e Device and Area/System level device type configuration are not migrated for Third-party
device types, Classic device types (PAC1500, 3VL COM21, GMD), SEM3 and PAC1200.
However, Archival configuration for the devices will be migrated in case the measurement

point is selected for data migration and data is available.

e The migration of the distributed system must be done for each project separately.

If the distributed project has source elements from another distributed project, then

those source elements will not be migrated and has to be re-configured in new

powermanager system after migration.

Migration of devices is handled as below:

Device Migration Comments
Supported
PAC Devices 4 PAC1500 is migrated as a third-party device type. Refer
Prerequisites for Import section for more information.
SEM3 v _
SICAM Devices v P850 and P855 will be migrated as PAC5100 and PAC5200
respectively.
Breakers v 3VLCOM?21 is migrated as a third-party device type. Refer
Prerequisites for Import section for more information.
Generic Modbus v This device type is migrated as a third-party device type.
Device Refer Prerequisites for Import section for more information.
Manual x -
Measuring Device
v

Virtual Devices
(Logical Devices)

e Virtual devices include:
- Average Value
- Calculation Value
- Virtual Counter
- Converter
e  KPlis migrated as a virtual device type.
e Virtual devices are not listed for data export. All the
result values are selected for export.
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Monitoring x Monitoring functions include Limit Control and Load
Functions Monitoring.

Third-party 4 -
Devices

(XML imported
Third-party Device
types)

e The descriptions of Areas and Sectors are not migrated from powermanager V3.6 HF1 to
new powermanager.

e System and Area level configurations of PAC5100 and PAC5200 device types are
considered for P850 and P855 device type respectively in new powermanager.

e OPC UA/DA and MindSphere configurations are not migrated as these features are not
supported in new powermanager.

e Manually corrected values are migrated.

e Alarm configuration of 3VLCOM21, PAC1500, GMD and third-party device types (xml
imported device types) will not be migrated. If necessary, reconfigure the alarms after
migration.

3 Export from powermanager V3.6 HF1

This section provides information on the export operation required for migration.

Pre-export Checklist:

e Ensure you have sufficient disk space available for the export operation.

e Archive backups of powermanager V3.6 HF1 should be re-mounted if needed for data
export.

e Ensure you take project and data backup before migration.

3.1 Prerequisites for Export

Login to powermanager V3.6 HF1 and verify all the required configurations and data of the project
to be migrated are available. Perform the following steps to run the Powermanager Migration
Export Tool.
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e Download and unzip the file containing the Migration Tool from the SIOS portal.

“ st mare

T This PC Local Disk (C:) Migration Teol Project_Export_Tool

ke

# Quick access

dplist
= Desktop
msg
& Downloads
panels
Documents scripts
« Pictures pmMigration AM
Archive
dplist
&. Local Disk (C

Migration Configur
& OneDrive

% This PC

P Network

e Run the pmMigration batch file as administrator.
- You will be prompted to enter the project path.

e Select the path of the project you want to migrate.
The path can be like the below example:
C:\SENTRON\ProjectName

e Enter the project path and click Enter.
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e Stop the project and close all powermanager applications and consoles to proceed with

migration.

NOTE: The Powermanager Migration Export tool is available in English and German languages.
The language will be selected by the tool depending on the available operating system. The
language is set to English for all operating systems other than German.

e Restart the project to be migrated.
- The Powermanager Migration Export tool login screen appears. The Powermanager
Migration Export tool is added as a new User Interface (number 10) in the powermanager

Console.
B powermanager: Console - &) X
4 P ey m [~ - L3 't
Project
DEMO_MIGRATION_PM3X - &g B

Manager - (Process Monitor. Starting project)

St Descnption No Options AW
Archive Manager 3 -num3 S
Archive Manager 4 -num 4 (1]
Archive Manager 5 -num5 -
Archive Manager 6 -numb @
Archive Manager 7 -num7
Archeve Manager 8 -rum B8 -
Archive Manager 9 -num9
Event Manager 1 -dbg 18
Control Manager 1 -fpvss_scrpts
Modbus Driver 1 -num 1 £
Modbus Driver 2 -num 2
Control Manager 2 -num 2 -f pm_s| M
User Interface 1 -num 1 -p visiol -

0 User Interface 2 -num 2 -p visiol 2
Control Manager 3 -mum 3 EC_En
Control Manager 4 -num 4 -f pm_a|

0 Control Manager 1 -extend -LoadA|

0 OPC DA Sarver 2 -rum 2

0 OPC UA Server 1 -num 1

I Distribution Manager 1 N

0 User Inteface 3 -m gedi -user

o

-num 10 -p visi ¥

Bl User Interface
< >
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e Enter the Username and Password used to login to powermanager V3.6 HF1 project to

login to the migration tool.
m Vision_1:

vision\pm\Migration\pm_Migrat..

Powermanager Migration

Domain name: DES

User name |

Password

Confirm

Cancel

NOTE: You must be a powermanager V3.6 HF1 Admin user to login to the Powermanager

Migration Export tool.

| Configuration Export | Data Export

T
Devices | Report Templates Miscellaneous  Export

Languages

Language 1 Englet

The Powermanager Migration Export tool is now available.

O

Devices

Language2* [Gemen

Report Templates.

Miscellaneous

Export

Devices

Select Device name Device type Device Group Area Sector >
“ GMD MB Standard Devices DefaultArea
p850_P2 P850 Standard Devices DefaultArea
PAC1200_project2 PAC1200 Standard Devices PACdevices
PAC1500_P2 PAC1500 Standard Devices PACdevices
PAC1661_P2 PAC1651 Standard Devices PACdevices
pac1651_p2 PAC1651 Standard Devices DefaultArea
& PAC1661_P2_1 PAC1661 Standard Devices DefaultArea
PAC1662_P2 PAC1661 Standard Devices PACdevices
%] PAC1665_P2_1 PAC1665 Standard Devices DefaultArea
PAC1682_P2_1 PAC1682 Standard Devices DefaultArea
PAC2200_P2 PAC2200 Standard Devices PACdevices
PAC3200_P2 PAC3200 Standard Devices Area_Level PAC
PAC4200_P2 PAC4200 Standard Devices System_Level
SEM3_P2 SEM3_SEM3 Standard Devices PACdevices
[0 Manual_measure_P2 ingDevice Standard Devices DefaultArea v

Notes:

Third Party Device XMLs

1. Manual Measuring Device, Load Monitoring, and Limit Control device types are not supported for migration.
2. Generic Modbus Device, 3VLCOM21, and PAC1500 device types will be considered as third party device types in new powermanager after migration

Third Party Device Type
CamilleBauer_EMMOD_201
PAC3200TPD
SICAM_Q100

Save

0
1
1

Browse
Browse

Number of Devices for the device type Select XML file used for creating the third-party device type Path of XML

C./TPD/CamilleBauer_ EMMOD_201 v1.0.1/CamilleBauer_EMMOD_201 |
C./TPD/PAC3200TPD/PAC3200TPD xml

Browse.

{CJ/TPD/SICAM_Q100_v1.0.0/SICAM_Q100.xm|

3.2 Configuration Export

Ensure that all the prerequisites mentioned in the Prerequisites for Export section are met.

Perform the following steps for Configuration Export.
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NOTE: We recommend you stop all device communication before proceeding with the export
operation.

Devices Tab

e Select the required description language from the Languages section.

Languages

Language 1 English Language 2 * German h

Languages: Allows you to select the description language. This section has the following options:
Language 1: Displays the default language assigned for all descriptions. This field cannot be
changed.

Language 2*: Allows you to select the description languages from the available list of supported
languages. This is a mandatory field.
e By default, all supported devices from the Devices section will be selected.

Devices
Select Device name Device type Device Group Area Sector al
GMD MB Standard Devices DefaultArea
p850_P2 P850 Standard Devices DefaultArea
PAC1200_project2 PAC1200 Standard Devices PACdevices
PAC1500_P2 PAC1500 Standard Devices PACdevices
PAC1661_P2 PAC1651 Standard Devices PACdevices
pac1651_p2 PAC1651 Standard Devices DefaultArea
PAC1661_P2_1 PAC1661 Standard Devices DefaultArea
PAC1662_P2 PAC1661 Standard Devices PACdevices
PAC1665_P2_1 PAC1665 Standard Devices DefaultArea
PAC1682_P2_1 PAC1682 Standard Devices DefaultArea
PAC2200_P2 PAC2200 Standard Devices PACdevices
PAC3200_P2 PAC3200 Standard Devices Area_Level PAC
PAC4200_P2 PAC4200 Standard Devices System_Level
SEM3_P2 SEM3_SEM3 Standard Devices PACdevices
=] Manual_measure_P2 Device Standard Devices DefaultArea v
Notes: 1. Manual Measuring Device, Load Monitoring, and Limit Control device types are not supported for migration.
2. Generic Modbus Device, 3VLCOM21, and PAC1500 device types will be considered as third party device types in new powermanager after migration.

Devices: Allows you to select the device configurations to be migrated. This section has the
following columns:
Select: Select the checkbox under this section to select the device. All the devices supported for
migration is selected by default. Migration non-supported devices are highlighted in grey and
cannot be selected for migration. Such devices are not migrated even as Third party devices.
Device Name: Displays the name of the selected device.
Device Type: Displays the device type.
Device Group: Displays the device group.
Area: Displays the area under which the device is available.
Sector: Displays the sector hierarchy under which the device is available.

NOTE: Device passwords are not included in the migration operation. Update the device passwords in
new powermanager after the completion of migration.

e Select the required third-party device type XMLs under the Select Third Party Device XMLs

section.
Third Party Device XMLs
Third Party Device Type Number of Devices for the device type Select XML file used for creating the third-party device type Path of XML
|CamilleBauer_EMMOD_201 0 Browse C:/TPD/CamilleBauer EMMOD_201_v1.0.1/CamilleBauer EMMOD_201 |
|PAC3200TPD 1 Browse C:/TPD/PAC3200TPD/PAC3200TPD .xml
YSICAM‘QWU 1 Browse :C:/TPD/SICAM_Q100_v1.0.0/SICAM_Q100.xml
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Select Third Party Device XMLs: Allows you to select the required third-party device type XML to be
migrated. This section has the following columns:

Third-Party Device Type: Displays the third-party device type

Number of Devices for the device type: Displays the number of devices of the device type.
Select XML file used for creating the third-party device type: Allows you select the third-party
device type XML files.

Path of XML: Displays the location of the third-party device type XML files.

Click Save.

NOTE: You must select the XML files for all the third-party devices selected in the Devices section.

Report Templates Tab
e By default, all the Report Templates will be selected. De-select any report templates if
required.

Report Templates

Select Report Template Report Type A
%] AbsoluteEnergyTempit Absolute Energy
M abs_logical Absolute Energy
%} CostCenterTempit Cost Center
%] EnergyAnalysisTemplt Energy Analysis
%) EnergyExportTemplt Energy Export
%] KPiTemplt KPI
M kpitemp2 KPI
“ LoadDurationTemplt Load Duration
%] LoadVarianceTempit Load Variance
“ StandardTemplt Standard
%} StandardThirdParty Standard
M Standard_sensor Standard
%] standardtemp2 Standard
M std_blank Standard
“ TotalEnergyTemplt Total Energy
%] Top_10_Active_Energy Top 10 Energy
%} Top_10_Reactive_Energy Top 10 Energy
%] PowerPeak_Template Power Peak v

Notes: 1. The tool does not create any back up of the generated reports. Create a back up of all generated reports manually, if required.
2. Sankey report templates will not be migrated
3.Top 10 active & reactive energy and configured power peak analysis will be exported as report templates.

Report Templates: Allows you to select the report templates. This section has the following
columns.

Select: Select the checkbox under this section to select the required report template. All the
report templates are selected by default.

Report Template: Displays the report template name.

Report Type: Displays the report type.

NOTE: 1) Only report templates are migrated and not the generated reports.

12 of 31

2) Migration is not supported for Sankey Report.

)
)
3) Only scheduling configuration of the Top 10 report templates is migrated.
4) The Power peak analysis is migrated as a report template.

)

5) KPl and Energy Export report templates are migrated as Standard report templates in
new powermanager.

Click Save.
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Miscellaneous Tab

e Create email configurations backup under the E-mail Configurations section.
E-mail Configurations

The e-mall configurations will not be migrated Do you wanlt to generate a backup e with email configurations?

@) Yes O No

E-mail Configurations: Allows you to create a backup of the email configurations.

Select Yes to create a backup of all email configurations.

NOTE: We recommend you create a backup of the email configurations. The backup file is not
imported as a part of the migration import operation. Refer the backup file to configure the E-mail

in new powermanager.

e Create reactions backup under the Reaction Plans section.

Reaction Plans
The reaction plans will not be migrated Do you want to genarate a backup file with reaction plans?

(@) Yes [

Reaction Plans: Allows you to create a backup of the reactions.

Select Yes to create the backup of all reactions.

NOTE: We recommend you create a backup of the reactions. The backup file is not imported as a
part of the migration import operation. Refer the backup file to configure the reactions in new
powermanager.

e Create system alarms backup under the System Alarms section.
System Alarms

The systerm alarms will not e migrated. Do you want v ganarate a backup fila with system alarms?

% Yes ) Mo

System Alarms: Allows you to create a backup of the system alarms.

Select Yes to create backup of all system alarms.

NOTE: We recommend you create a backup of the system alarms. The backup file is not imported
as a part of the migration import operation.

e Migrate system settings under the System Settings section.
System Settings

Do you want to migrate system level setfings?

@) Yes O Mo

System Settings: Allows you to migrate all system settings.

Select Yes to migrate all system settings and configurations.

All archive smoothing, driver smoothing, system dashboard, and synchronization configurations are
included.
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e Migrate system trends under the System Trends section.
System Trends

Do you want to migrate system trends?

o) Yes L) No

System Trends: Allows you to migrate all system trends.
Select Yes to migrate all system trends.

e C(Click Save.

Export Tab

e Select the path for the export and complete the configurations export under the Export
Configuration section.

Export Configuration

Select a path to export the configuration

Path |D/SENTRON/PowermanagerProject/data/M _Export

Export Configuration

Path: Allows you to select the path to where the files need to be exported to.
Export Configuration: Allows you to complete the complete configurations export.

The file containing the configurations export is available in the above specified folder.

3.3 Data Export

Archived data over required period for selected devices is also a part of this operation. To perform
data export, ensure that the configuration export is complete, and all the prerequisites mentioned
the Prerequisites for Export section are met. Perform the following steps for data export.
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Measurement Points Tab

e Select Archive Configuration for the measurement points to be migrated.

Standard Devices
Select Archive Configuration |

(®) Defaut O Current

Devices

[3VA27Breaker (3VA27)
3VAETUSBreaker (3VAETUS)
3VAETU8Breaker (3VAETUS)
3VLCOM21Breaker (3VLCOM21)
3WLBreaker (3WL)
3WL10Breaker (3WL10)
GenencModbusDevice (MB)
GenencModbusDevice_1 (MB)
GenercModbusDewice_2 (MB)
P850Device (PAC5100)
P855Device (PAC5200)

PAC1200Device (PAC1200)
<

(O Custom

Devices: Allows you to select the devices for which the data must be exported. All the devices

selected in the configuration export are listed here.

Default: Select to export the measurement points that are archived by default when a device is

created in new powermanager.

Example: The measurement points archived by default for a PAC3200 device are active energy

import tariff 1 and cumulated active power import.

Avallable Measurement Groups

Available Measurement Points

Note: The above tables only show the archived measurement points for each group.

(EM) cumulated active power import

Powermanager, Migration Tool
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Current: Select to export all the archived measurement points configured in powermanager V3.6

HF1.

Measurement Points.

Available Measurement Groups.

Available Weasurament Points

Selected Measurement Points
voltage L1-N

voltage L2-N

voltage L3-N

current L1

current L2

curent L3

collective apparent power

collective active power

collective reactive power (VARn)
work hour counter

active enesgy import tariff 1

active energy export tariff 1

reactive energy import tarif 1
reactive energy export taniff 1
apparent energy tarif 1

load profile synchronisation
acknowledge diagnostics

davice reset (no change of IP Address)
reset maxima

reset minima

reset energy counters

relevant param. changes

counter reset

(EM) cumulated active power import
(EM) cumulated active power export
digital output 0

switch output group

Note:  The above tables only show the archived measurement points for each group

X

X

Custom: Select to choose measurement points from all the archived measurement points for the
selected device in powermanager V3.6 HF1.

Measurement Points.
Availadle Measurement Groups
Current

Power

Power interval
Power factor

Available Measurement Points

voltage L2-N
voltage L3N

Voltage A

Frequency v

SelededWeasiement Points
voltage L1-N

Note:  The above tables only show the archived measurement points for each group.

NOTE: Logical devices are not listed for data migration. All the result values are selected for export.
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Third Party Devices

Select Archive Configuration

@) Current () Custom

Devices

Schneider PMB10Device (Schneider PME10)

Devices: Allows you to select the devices for which the data must be exported. All the third-party
devices selected in the configuration export are listed here.

Current: Select to export all the archived measurement points configured in

powermanager V3.6 HF1.

Custom: Select to choose measurement points from all the archived measurement points for the
selected device in powermanager V3.6 HF1.

e C(Click Save.

Duration Tab

e Select the duration for which the data must be exported.

Duration for Energy Consumption & Power Interval Values

Select™ 3 Menths - Starttime 2021.04.28 14:08 Endtime |2021.07.28 14:08

Duration for All Other Values

Select 3 Months - Starttime 2021.03.07 16:33 Endtime |2021.07.28 14.08
Fi Time Based Smoothing Smoothing Interval 1 hour -
Motes 1. Start and End time format is YYYY.MM.DD HH:MM

2. Default value of the End time is the completion time of the configuration export

NOTE: The default time duration for the data export is from the selected start time to the time
configuration export is completed.

Duration for Energy Consumption & Power Interval Values: Allows you select the duration for
which the data must be exported for energy consumption and power interval values. This section
has the following options.

Select*: Select the duration for which the data must be exported from this dropdown.

Start time: Displays the start date and time for the selected duration, if the default duration is
selected in the Select* dropdown.

Allows you to select the start time and date, if the custom option is selected in the Select*
dropdown.
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End Time: Displays the end date and time for the selected duration, if the default duration are
selected in the Select* dropdown.
Allows you to select the end time and date, if the custom option is selected in the Select*

dropdown.

Duration for all Other Values: Allows you to select the duration for which the data must be
exported for all other values except energy consumption and power interval values. Default
duration is set to 3 months.

NOTE: Other values data (excluding energy consumption and power interval) can be exported only
for last three months.

Time Based Smoothing: It allows you to reduce the volume of data to be exported.

Smoothing Interval: Select the smoothing interval for time based smoothing. This helps to reduce
the amount of data considered for migration and to reduce the SQL size needed. After the
smoothing interval time has elapsed, the next value will be considered for migration. Any values
during the smoothing interval are discarded.

e Click Save.
Export Tab
e (lick Calculate Quick Forecast or Calculate Detailed Forecast to view the SQL storage
analysis needed for new powermanager database.
Forecast
SQL Storage Forecast Quick Analysis S0L Storage Forecast Detailed Analysis
Shor Term Storage Long Term Storage Total SQL Storage Shon Term Storage Long Term Storage Total SQL Storage
Calculate Quick Forecast Calculate Datailed Forecast
SQL Storage Forecast Quick Analysis: Provides you a detailed estimate of the required SQL storage
space.
SQL Storge Forecast Detailed Analysis: Provides you a detailed estimate of the required SQL storage
space. This process can take a few minutes to an hour depending on your data.
e (lick Data Export in the Data Export section to proceed with the export operation.

Export Data

Data exported will be present in the below path

Data Export

Export Data: Displays the path where the data export files are made available.

The file containing the data export is available in the above specified folder.
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3.4 Post Export Operations

Perform the following steps to proceed with migration.

e Copy the files containing the configuration and data export to the machine with new

powermanager.

4 Import to new powermanager

This section provides information on the import operation required for migration.

Pre-import Checklist:

e During installation of new powermanager, select checkbox Migration (select if you are

migrating from powermanager V3.6 HF1) and click Next.

NOTE: If the checkbox is not selected, Powermanager Migration feature will not be
available after installation.

To add Powermanager Migration feature post installation follow the below steps:

- Launch Powermanager SMC and Navigate to Projects node.
- Click Stop.

System Management Console

SIEMENS
System
¥ Projects

¥ Wepsites
¥ Powermanageriebsie
PMDashboard

¥ Datoouse infrastructure
¥ (0ca)\GMS_HDB_EXPRESS
HDB [HDE]
NDB [Notification]
centificate

Project Settinas Web Services Settings

Powermanager

» ¥ Server Project Information -

Project status: @ stopped

Project name Powermanager

Project path:

N B

Languages
enUs

2}

en-GB
de-DE
Q T

Linksd HDB:

Linked HDB state:
System names

® Distribution participant:

Cuesy Cache:

Active project : Powermanages / Stooped
| Wotincation ]

CSiemens\SENTRON pewermanagen Powermanager

(localj\GMS_HDB_EXPRESS\HDB

Connected - secured

Data version: 60380
K3 cncoprea
System I0: 1
Dist port:
Query Cache port: 4779

Frt Infomation
Pmon port

Data port:

Event part:

HDB Reader port:
Dist port:

Query Cache port:

CCom port:

[ ]

4993

Mame

Advanced Reporting

Application Host Base

Energy and Power Management Common
Madbus TCP

Madbus TCP Powes Devices

NodeMag

Data Version
60.0007.0
600010
60010:0
600040
60027.0
6000020

Status
Updated
Updated
Updated
Updated
Updated
Updated

¥ Extension Information

Ready

» Communication Securty

Manager Name Mode Status Options

Process Monitor WCClLpmon manual @ Stopped =~

- Close all the applications related to powermanager.

- Launch Update powermanager V6.0 from desktop.
NOTE: If Update Powermanager V6.0 is not available on desktop, refer to path
"C:\Siemens\SENTRON\powermanager\GMSMainProject\Bin\Gms.InstallerSetup.exe"
Administrative rights are required to launch Update Powermanager V6.0.

Powermanager, Migration Tool

L1V30600299C | Edition 08.2022

19 0f 31




- Click Yes on User Account Control window.

Siemens.GMS.InstallerSetup

Verified publisher: Siemens AG
File origin: Hard drive on this computer

Show more details

- Click Next.
m SENTRON powermanager V6.0 Setup - Server -
‘Welcome to the SENTRON powermanager Install Wizard.
This wizard will install the management station and its prerequisites on your computer. To continue, click Next.

Select a Language for the Installation Wizard from the choices below.

®) en-US

A Warning: This program is protected by copyright law and international treaties.

Add Additional Language | | Next | [ cancal
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- Select Server and click Modify for Feature Selection.

m SENTRON powermanager V6.0 Setup - Server —
Setup Type Selection
Choose a setup type for installation.
® Server Feature Selection
FEP
Back | | Next ‘ ‘ Cancel
- Click Add Em.

m SENTRON powermanager V6.0 Setup - Server —

Feature Selection
Select feature(s) to install.

Select Al Deselect Al AddEm | | ok
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Browse for powermanager setup folder.
Navigate to powermanager setup folder\DCC\EM\Powermanager_migration and

click OK.

Browse For Folder

|
b3

Advanced_Reporting
Application_Host_Base
D3_Visualization
EnergyAndPowerManagemer
Installer

MNS

Modbus

NodeMap
PowerManagement_Modbus_

¢ Powermanager
@R  Powermanager Migratio

P U U ——

-

b b Scripting
bk SMC
}.  Web_Service_Interface
4. languages
SR

oK | [ concel

1>

Click OK.

ﬁ SENTRON powermanager V6.0 Setup - Server

Feature Selection

Select feature(s) to install.

4 Energy and Power
Powermanager Migration

SelectAll | | Deselect Al

AddEm | | oK
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- Click Next.

m SENTRON powermanager V6.0 Setup - Server -
Setup Type Selection
Choose a setup type for installation.
® Server Feature Selection
FEP
Back | | Next ‘ ‘ Cancel
- Click Next.
m SENTRON powermanager V6.0 Setup - Server -
Installation Folder
The setup will use the following folder to install powermanager
Installation folder:
CA\Siemens\SENTRON\powermanager\, Change
Name Total size (GB) Free space (GB) Required (GE) Temp (GB) Remaining (GB)
C\ 200,000 5176 0.029 0.029 5.117
D 275.839 257117 0.000 0.000 257117
0 Note: Spaces and special ck s are not all din the i ion folder path.
Back | | Next ‘ ‘ Cancel
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- Click Install.

m SENTRON powermanager V6.0 Setup - Server -

Ready to Install the Program

Following components are ready for installation

Name Status

Powermanager Migration Pending

Back | | Install ‘ ‘ Cancel

- Click Close.

m SENTRON powermanager V6.0 Setup - Server -

Installation Complete

Installation successful.

Click Close to exit.
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e Add Powermanager Migration feature in the project using the below steps:
- Launch Powermanager SMC and navigate to Projects node.
- Select project name and click Add to project.

System Management Console
SIEMENS Active projact : Powermansger / stopped Meru
Syotem Project Scttings Web Services Seftings | Notification | .
v Projects
Powermanager
V Wensites
¥ Powermanagedtiebsite (SR v Server Project Information 1
Dashboara
PMReonts Project sms: @ stope=d Dsta version: 60380 Port Information
PMWenClient Prman port: 1999
WS Projact rame: Powermanager
Inte
v ?l}xu\ziﬁ%;_’é@ms N Project path CASiemens\SENTROM\powermanagen\Powermanager Data port: 4897
HOB [HCE] 4 Languages:
NDB [Netification] B nguag s . Event part 258
SHERIE A HDE Reader port: 774
o Ot port:
de-DE Query Cache port; 79
o = CCom port:
Linked HDE: Docal\GMS_HDE_EXPRESSIHDE Bl ronptec:
Linked HDB state:  Connected - secured
System name: Syster System ID: i
£ | Distibution porticipant: Dist port:
Query Cache: Query Cache port: 4179
¥ Extension Information
Name: Data Version Status |
i Advanced Reporting 6000070 Updated -
Application Host Base 600010 Updated
Energy and Power Management Common 600100 Updated
Modbus TCP 600040 Updated
Modbus TCP Fower Devices 600270 Updated
HodeMap 6000020 Updated i
» Frofiles
Manager Name Mode Status Options. |
Frocess Monitor WEEILpmon manual  stopped -
Ready

- Select Powermanager Migration and click OK.

Select Project Extensions

WV [/] Energy and Power
[/] Powermanager Migration

- Click Save.
- Start the project.

e Ensure that you have the required new powermanager license available and activated.
Licensing for powermanager is controlled through a tool called, License Management Utility (LMU).
Once powermanager is installed, the License Management Utility (LMU) is installed on every
system.

Before launching the powermanager client application, you must first enable and manage licenses
for powermanager. Otherwise, only the demo licenses are configured, and you will need to close
the powermanager client application in very short time.
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To protect powermanager against piracy, a special activation is required. You can activate the
license for powermanager from LMU using the below steps:
- Launch SMC either by double-clicking the SMC icon on the desktop or from
Windows Start menu.
- Refer to Help > Engineering Step-by-Step > Installing the Software > Additional Installer
Procedures > Activating a Customer License.
e Ensure that new powermanager supported version of SQL is available.
e Ensure that database size and storage size are sufficient corresponding to the SQL forecast
of the SQL operation.
e Ensure that a historical database (HDB) is connected and accessible to the project, the
long term storages created and switched to ON state.
You can create long term storages using the below steps:
- Launch Powermanager SMC either by double-clicking the SMC icon on the desktop or from
Windows Start menu and click Yes.
- Inthe SMC System tree, select History Infrastructure.
- Click Scan Local.
- When the scan is completed, select GMS_HDB_EXPRESS SQL.
- Click Link.
- Click Add to create the HDB.
- Inthe Long Term storage section, click Add Storage to create long term storage.
- Select the Start check box for the storage.
- Click Save.

The History Database is created and displays in the SMC tree. This may take a few minutes
depending on the selected database size. When you create a new HDB it gets automatically linked
to the SQL Server. The long term storage is created when the state in the State column in the
Storage table changes to ON.

For additional information, refer to Powermanager Help >Engineering Step-by-Step > Setting Up the
Project > Creating History Infrastructure > Create a New HDB with Long Term Storage.

4.1 Prerequisites for Import

Ensure that new powermanager Server is installed, refer to Readme.pdf (section 4.1 Installation
Prerequisites). You have the privileges of a DefaultAdmins user or a PowerManagerAdmins user.
If user had reports scheduled in powermanager V3.6 HF1, ensure that Software user account is
created in new powermanager, and group membership is assigned to PowermanagerAdmins.
Enter created Software account username during configuration import.

Refer new powermanager help section for more details: Engineering Step-by-Step >User and User
Group Administration >User Administration.

NOTE: Migration is not supported for new powermanager Client setup.

Perform the following steps to proceed with migration:

e Copy the files containing the configuration and data export to the machine with new
powermanager.
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e Create the third-party device types, if any.
You must create the third-party device type to be migrated in new powermanager. JSON files for
corresponding third-party device types are created by the migration tool during the configuration
export. These JSON files are available in configuration export folder. You can create third-party
device types using the below steps:

Select Applications > Powermanager.
The System tab displays.

Select Third Party Device Type expander and proceed as follows:
=  Dragand drop the library to the Library Name field.
=  Click Browse to select the JSON file.

= Inthe Open dialog box, select the required JSON file from the location and click Open.

Click Create Device Type.

NOTE: Device types like 3VLCOM21 and PAC1500 are supported in powermanager V3.6 HF1 but not
supported in new powermanager. JSON files for these device types are created as a part of the export
operation.

These files are available in path: [Projectname]_Backup_For_Migration(yyyy-mm-dd-
hh.mm)\Configuration\Device\Classic_DeviceType_Jsons.

e Edit the JSON files for the Generic Modbus Device (GMD) types, if any.

A JSON file is created for GMD type by the migration tool during the configuration export. This

JSON file is available in configuration export folder.

Open the JSON file of the GMD type using the powermanager device engineer tool. Perform the

required property configurations and create the new JSON files for corresponding GMD groups.

Consider the below example to create GMD device type JSON files in powermanager device

engineer tool:

- Open JSON file GenericModbusDevice_Classic from configuration export folder in third-party
tool PowermanagerDeviceEngineer.

- Review and configure Device Features page properties as per powermanager V3.6 HF1 and
click Next.

- Review and configure Device properties page properties and click Next. Make sure the
property configurations are correct and configured as per powermanager V3.6 HF1 GMD
device type.

- Review and configure Device Configuration and save the JSON file.

- If necessary, rename the device type using Edit option from Device Type Name.

NOTE: Do not rename the datapoint properties. If you rename, configuration and data import
failure will occur.
e |ogical grouping of GMDs:

- If multiple GMDs are created with same configuration in powermanager V3.6 HF1, then during
bulk device creation in new powermanager, you must select the same device type.

- For different GMD configurations of powermanager V3.6 HF1, individual JSON files should be
configured in powermanager device engineer tool.

- One JSON file should be created for one type of configuration and that type should be selected
during bulk device creation.
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- Consider the below example to understand logical grouping of GMD and create corresponding

JSON files in powermanager device engineer tool:
Consider three devices GMD1, GMD2 and GMD3 in powermanager V3.6 HF1.
GMD 1 has configuration 1 and GMD?2 has configuration 2 and GMD3 has similar configuration
as GMD1. In this case user must create two separate GMD device types:
=  One device type JSON for GMD1 and GMD3 as they have same configuration
=  One device type JSON for GMD?2

MODBUS Configuratio 2 0 fion | Bulk Device Creation v o
Powermanager -
Select file to create devices
CA\3%_p Migration_BulkDevic
Select Device Name | Device Description - Default Language (English) | Device Description - Additional Language | Device Type Area -
&~ etu_8 etu_8R etu_8 IVAETUR Area_level_Inheritance
" coM_21 COM_21 COM_21 3VLCOM21_Classic NotSupported_Devices
i 3WL-sim 3WL-sim 3WL-sim 3wWL Breakers
~ WL 3WL_1R 3IWL1 3WL System_level_Inheritence
v 3WL_10 3IWL_10R 3IWL_10 3wL1 Area_level_Inheritance
i GMD1 GMD1 GMD1 GenericModbusDevice_Classic_land3 u Areal
v GMD2 GMD2 GMD2 GenericModbusDevice_Classic_2 u Areal
v GMD3 GMD3 GMD3 GenericMedbusDevice_Classic_land3 u Areal
i PB50-1 PB50-1 PB50-1 PAC5100 NotSupported_Devices
i PACP850_1 PACP850_1 PACP850_1 PAC5100 Dummysector2
¥ P855-1 P855-1R PB55-1 PAC5200 System_level_Inheritence
¥ 1200-1 1200-1R 12001 PAC1200 System_level_Inheritence
¥ 1200 2 1200 2 1200 2 PAC1200 Area_PAC |
e | 3
Quenwrite if the devices exist Device already exists Error in device specification

e Create the devices in new powermanager under Bulk Devices Creation tab:

- In Engineering mode, click Bulk Device Creation.

- Browse .csv file to create devices.

NOTE: A .csv file with the device configurations is created during the export operation. Use this
.Csv to create the devices.

These files are available in path: [Projectname]_Backup_For_Migration(yyyy-mm-dd-
hh.mm)\Configuration\Device\BulkDeviceCreation.

- Select the required Device Type from the available dropdown for GMDs.

- Provide the Username and Password for all SEM3 devices.

- Import the JSON files to new powermanager to work with these devices. Refer steps from
section 4.1 Prerequisites for Import > Create the third-party device types to import JSON files
to new powermanager.

- Click Create Devices.

e Switch to operating mode and start all device communication.
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e Switch to engineering mode and navigate to Migration tab to proceed with the import
operation.

MODBUS Configuration Summary Device Type Configuration | Bulk Device Creation Migration

Select the folder with the migrated files.

Step 1 - Configuration Import

| ‘
Step 2 - Data Import

Complete configuration import to proceed with data import. |

4.2 Configuration and Data import

Perform the following steps to proceed with configuration import.

e Select the folder with the migrated files under the Import expander.

Powermanager

Select the folder with the migrated files,
CA3x_prajectfiles\Migration_test\NEw_toai\Test_1_Backup_For_Migration{2022-01-25-19.12} m

Select the folder exported from powermanager V3.6 HF1: Allows you to select the folder with the
configuration or the data export.

Step 1 — Configuration Import: Allows you to import the file containing the configurations.

MODBUS Configuration Device Type Configuration | Bulk Device Creation

Powermanager

Select the folder with the migrated files.
€\3x projectfiles\Migration test\NEw_toolTest 1 Backup For Migration(2022-01-25-18.12) | Bowse |

Step 1 - Configuration Import
Enter Schedule Report details.

Username Select path
] [E=]

|
Step 2 - Data Import

Complete configuration import to proceed with data import.

Step 2 — Data Import: Allows you to import the file containing the data.
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Dbject Configurator

Powermanager

Select the folder with the migrated files.
C3x_projectfiles\Migration_test\NEw_tool\Test_1_Backup_For_Migration(2022-01-25-19.12)

Step 1 - Configuration Import

o Configuration impert successful. A migration import summary is created with configuration import details in <Project Path>/Data/Migration.

Step 2 - Data Import

System MODBUS Configuration Summary Device Type Configuration | Bulk Device Creation Migration

The configuration and the data import are successful.

Object Configurator

Powermanager

Select the folder with the migrated files.
CA3x_prajectfiles\Migration_test\NEw_toal\Test_1_Backup_For_Migration(2022-01-25-19,12} m

Step 1 - Configuration Import
0 Configuration import successful. A migration import summary is created with configuration import details in <Project Path>/Data/Migration.

|
Step 2 - Data Import

Q Data import successful. The migration import summary is updated with data impert details in <Project Path>/Data/Migration.

System MODBUS Configuration Summary Device Type Configuration | Bulk Device Creation Migration

NOTE: You are recommended to verify all the configurations in new powermanager
system after migration.

5 Migration Summary

Configuration Export, Data Export, Configuration Import and Data Import are the activities
performed during migration. After every export and import activity, migration summary report will
be created for each activity.

Export summary will be available as <Exported Folder>/Migration_Export_Summary.txt

Import summary will be available as

<Project Path>/Data/Migration/Migration_Import_Summary.txt

NOTE: You can compare between export and import summary reports to get the migration status.

30 of 31 Powermanager, Migration Tool

L1V30600299C | Edition 08.2022



6 Troubleshooting

Troubleshooting

Error

Situation

What to do

Data import could not start

User clicks on data import
with incorrect HDB
configuration

1.Verify if HDB is linked to the project.

2.Verify if Siemens GMS HDB service
is running in SMC (system node
>management tab >services section).

3.Verify if short term and long term
archives/storages are created in HDB
and in ON state.

After performing above
troubleshooting, proceed with data
import.

new powermanager

Migration tab is not available after login to[Migration EM is not

installed or not added in
the project

If Migration EM is not installed, refer
section Import to new
powermanager.

If migration EM is not added in the
project, click Add to project and add
powermanager migration EM.

Server is not properly running during
import in new powermanager

Migration(import) running
on HDB writer manager
goes to blocked state in
SMC

User should wait till completion of
complete migration activity.

The scheduled report file is corrupted

User trying to open the
generated scheduled
report file

In powermanager application re-save
the report definition.

1. Read the notes in the Readme.pdf file carefully.

2. For up-to-date hot fixes / service packs for powermanager see:

www.siemens.com/Powermanager/support

For further support, see the Technical Support information below.

Technical Support:

Internet: http://www.siemens.com/lowvoltage/technical-support
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